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Abstract
Motivation: Real evolutionary data often contain a number
of different and sometimes conflicting phylogenetic signals,
and thus do not always clearly support a unique tree. To
address this problem, Bandelt and Dress (Adv. Math., 92,
47-05, 1992) developed the method of split decomposition.
For ideal data, this method gives rise to a tree, whereas less
ideal data are represented by a tree-like network that may
indicate evidence for different and conflicting phylogenies.
Results: SplitsTree is an interactive program, for analyzing
and visualizing evolutionary data, that implements this
approach. It also supports a number of distances transform-
ations, the computation of parsimony splits, spectral analy-
sis and bootstrapping.
Availability: There are two versions of SplitsTree: an
interactive Macintosh version (shareware) and a command-
line Unix version (public domain). Both are available from:
ftp://ftp.uni-bielefeld.de/pub/math/splits/splitstree2. There is
a WWW version running at: http://www.bibiserv.techfak.uni-
bielefeld.de/splits.
Contact: huson@mathematik.uni-bielefeld.de

Introduction

Evolutionary relationships between taxa are most often
represented as phylogenetic trees, and many different algo-
rithms for tree construction have been developed (Swofford
et al., 1996). This is, of course, justified by the assumption
that evolution is a branching or tree-like process. However,
a set of real data often contains a number of different and
sometimes conflicting signals, and thus does not always
clearly support a unique tree.

To address this problem, Bandelt and Dress (1992a) devel-
oped the method of split decomposition. In contrast to
methods such as maximum parsimony and maximum likeli-
hood that reconstruct phylogenetic trees by optimizing cer-
tain parameters, split decomposition is a transformation-
based approach. Essentially, evolutionary data are trans-
formed or, more precisely, ‘canonically decomposed’, into a
sum of ‘weakly compatible splits’ and then represented by a
so-called splits graph. For ideal data, this is a tree, whereas
less ideal data will give rise to a tree-like network that can be

interpreted as possible evidence for different and conflicting
phylogenies. Further, as split decomposition does not at-
tempt to force data onto a tree, it can provide a good indica-
tion of how tree-like given data are.

There exist efficient algorithms for performing split de-
composition (Bandelt and Dress, 1992a) and for computing
splits graphs (Wetzel, 1995; D.H.Huson, in preparation).
Dress and Wetzel produced a simple implementation of split
decomposition (Wetzel, 1995) as an investigative tool to help
develop the general theory. Based on their work, a first public
version was developed by Wetzel and Huson (SplitsTree ver-
sion 1). The program described in this paper (SplitsTree ver-
sion 2) is a completely new implementation.

In this paper, we first review the concepts of splits, splits
graphs and the method of split decomposition, and then dis-
cuss the SplitsTree program in detail. For a number of bio-
logical applications of the split decomposition method, see,
for example, Bandelt and Dress (1992b), Dopazo et al.
(1993), Dress and Wetzel (1993), Lockhart et al. (1995),
Wetzel (1995), Dress et al. (1996), McLenachan et al. (1996)
or P.J.Lockhart et al. (in preparation).

Splits and splits graphs

Evolutionary relationships are generally represented by a
phylogenetic tree, T, i.e. a tree whose leaves are labeled by
a set X of taxa and whose remaining vertices are unlabeled
and of degree at least three. (We only consider unrooted trees
in this paper.) Any edge e of T defines a split S = {A,A} of
X, i.e. a partition of X into two non-empty sets A and A,
consisting of all taxa on the one side, or the other, of the
edge e. Such a system Σ of splits is called compatible if, for
any two splits S1 = {A1,A1} and S2 = {A2,A2} in Σ, one of
the four intersections

A1∩A2, A1∩A2, A1∩A2, or A1∩A2

is empty. Any phylogenetic tree T gives rise to a compatible
split system Σ. In 1971, Buneman established that, vice
versa, any compatible split system Σ corresponds to a unique
phylogenetic tree T. So, tree reconstruction for a given set of
taxa X is equivalent to computing a compatible system of
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splits ∑ for X and determining a weight for each split S that
corresponds to the length of the associated edge.

Hence, to obtain more general graphs, one must consider
less restricted systems of splits. Let X be a set of taxa. A
system of splits Σ of X is called weakly compatible if, for any
three splits S1, S2, S3 and all Ai � Si (i = 1, 2, 3), at least one
of the four intersections

A1∩A2∩A3, A1∩A2∩A3, A1∩A2∩A3, or A1∩A2∩A3

is empty (Bandelt and Dress, 1992a). So, in particular, any
two splits are permitted to be incompatible. Intermediately,
Σ is called circular if there exists an ordering x1,x2,…,xm of
the taxa such that for every split S�Σ there exists A�S with
A = {xp(S),xp(S) + 1,…,xq(S)} and1≤ p(S)≤ q(S)≤ m. One can
prove that a circular split system is always weakly compat-
ible and a compatible split system is always circular (Bandelt
and Dress, 1992a; Wetzel, 1995).

A splits graph representing a weakly compatible split sys-
tem Σ is a graph G(Σ) = (V,E) whose vertices v�V are la-
beled by the set of taxa X and whose edges e�E are straight-
line segments that represent the splits in Σ (see Figure 1).
More precisely, each split S = {A,A}�Σ is represented by
a band of parallel edges of equal length in such a way that
deleting all edges in such a band partitions the graph into
precisely two components: one containing all vertices la-
beled by taxa in A and the other containing all vertices la-
beled by taxa in A. The length of the edges representing a
given split S indicates its weight or support and is calculated
as the isolation index of S. For algorithms that compute splits
graphs, see Wetzel (1995) and D.H.Huson (in preparation).

Consider a weakly compatible system of splits Σ of a set
X of taxa. If Σ is compatible, then G(Σ) is a phylogenetic tree.
What is the situation if Σ is merely circular? Then G(Σ) can
be realized as a planar graph (Wetzel, 1995; D.H.Huson, in
preparation). Finally, if Σ is not circular, then in general G(Σ)
will not be planar. In biological applications, the arising split
systems are often either circular or mildly non-circular.

Split decomposition

Split decomposition is a method for obtaining a system of
weakly compatible splits with weights from a given set of
evolutionary data. So, assume we are given a set of taxa X
and a distance map d:X*X → R≥0 on X, i.e. a matrix repre-
senting the evolutionary distances between pairs of taxa.
Bandelt and Dress (1992a) showed that such a distance map
d has the following canonical decomposition:

d = Σ αS�δS + d0

Here, we sum over all possible splits S of X; the map
δS:X*X → R≥0 is the split metric on S that equals 1 if x and
y lie on different sides of S, and 0 otherwise; the number αS

Fig. 1. The splits graph for the distances listed in Figure 3. Each band
of parallel edges indicates a split. For example, the two bold lines
represent the split {Euglena, Olithodiscus} versus the other taxa.
The distance between any two taxa x and y corresponds to the sum
of weights of all splits that separate x and y, i.e. the sum of edge
lengths of any shortest path from x to y.

≥ 0 is the weight or isolation index of the split S; and the map
d0:X*X → R≥0 is the so-called split-prime residue and can-
not be decomposed further. A split S with αS > 0 is called a
d-split, and the system Σ of all d-splits is weakly compatible
and can be computed efficiently [see Bandelt and Dress
(1992a) for details].

If there is no split-prime residue, then the distance between
any two taxa x and y is precisely equal to the sum of weights
of all d-splits that ‘separate’ x and y, and thus proportional to
the sum of all edge lengths along a shortest path from x to y
in the splits graph. However, in general, the split-prime resi-
due will be positive and so the sum of weights will only give
an approximation (from below) of the original distances. The
fit of the approximation is measured by the sum of all ap-
proximated distances divided by the sum of all original dis-
tances. In biological applications, the fit is often quite high
and a small split-prime residue can be considered as ‘noise’.

If we are given a set of aligned sequences, then to apply
split decomposition we must first compute a distance matrix
d using an appropriate distance transformation. Alternative-
ly, one can compute the so-called parsimony splits, or p-
splits, directly from the sequences, as described in Bandelt
and Dress (1993). Yet another possibility is to use spectral
analysis (Hendy and Penny, 1992; M.D.Hendy and P.J.Wad-
dell, in preparation) to assign a weight (the so-called γ-value)
to each possible split of X. One can then greedily extract a
weakly compatible (or compatible) system of splits, i.e. by
considering all such splits S in decreasing order of weight
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and inserting the split S into Σ if it is weakly compatible (or
compatible) with all splits already in Σ.

Description of SplitsTree

SplitsTree is an easy-to-use Macintosh application that takes
as input a file containing sequences, distances, or a system of
splits, and produces as output a weakly compatible system of
splits and a splits graph representing the given data. It con-
tains a number of transformations to obtain distances from
sequences and methods for obtaining compatible or weakly
compatible split systems from distances or sequences.

Menus

SplitsTree offers the following menus: File, Edit, Layout,
Options, Method and Window. The File menu contains the
usual items for opening, closing, saving and printing docu-
ments. The Edit menu contains items for copying and past-
ing, etc.

The first group of items in the Layout menu can be used to
change the position, orientation and size of the displayed
splits graph. The Cycle item allows the user to specify the
circular order in which the taxa appear around the outside of
the splits graph. This feature can be used to produce the same
layout for different splits graphs produced from the same
data set by different methods. The Vertex Labels and Edge
Labels submenus can be used to decide whether the vertices
are to be labeled by the names or numbers of the taxa and
whether the edges are to be labeled by weight, number or
bootstrap support. The Equal Edges and To Scale items de-
termine whether the edges of the displayed splits graph are
drawn all with the same length, or in proportion to the isola-
tion index of the corresponding splits.

The Options menu determines how the given data are pre-
processed. The Taxa item enables the user to exclude certain
taxa from the analysis. Similarly, the Sites item can be used
to exclude certain sites and also codon positions. Moreover,
items are available for excluding whole groups of sites: Ex-
clude Gaps, Exclude Missing, Exclude Non Parsimony and
Exclude Constant…. In the latter case, one can choose to
exclude only a proportion of the constant sites, which can be
useful in connection, for example, with the LogDet trans-
formation (see Figure 1), as it provides a way of approximat-
ing a more continuous distribution for rates across sites
(Adachi and Hasegawa, 1995; Waddell, 1996).

The Options menu also offers a number of distance trans-
formations such as Hamming distances, Kimura 3ST (Kimu-
ra, 1981), Jukes Cantor (Jukes and Cantor, 1969) and LogDet
(Steel, 1994). The Nei Miller item is for computing distances
for restriction site data (Nei and Miller, 1990), and the PAM
250 item applies to protein data (Dayhoff et al., 1983). A
user-defined weight matrix can be supplied using the User
Matrix item.

Moreover, there are two items for determining distances
between groups of taxa, both suggested by Mike Steel: the
Fitch Sidow… item computes the distances between given
groups using a combination of methods from Fitch (1971)
and Sidow et al. (1992), whereas the Covarion… item is
based on Moulton et al. (1997).

Finally, SplitsTree checks for given distance data whether
the triangle inequalities hold. If they do not, then the Force
Triangle Inequalities item can be used to force them to, i.e.
by adding an appropriate offset to all distances.

The Method menu is the most important menu, as it deter-
mines which method is applied to produce a split system
from the given data. The first group of items all produce
weakly compatible split systems. The choices are: Split De-
composition (as described above), Parsimony Splits (Ban-
delt and Dress, 1993) and Spectral Analysis… (Hendy and
Penny, 1992; M.D.Hendy and P.J.Waddell, in preparation,
followed by a greedy selection of a weakly compatible split
system). The second group of items all produce compatible
split systems: Buneman Tree (Buneman, 1971; Bandelt and
Dress, 1992a), P-Tree (Bandelt and Dress, 1993) and Spec-
tral Tree (spectral analysis followed by a greedy selection of
a compatible split system).

For larger data sets, methods such as split decomposition
or computing the ‘Buneman tree’ tend to produce unresolved
split systems. This is because they involve computing the
minimum of a certain index over all quartets of taxa that are
separated by a given split to determine whether that split
should be included in the split system (Bandelt and Dress,
1992a). In an attempt to solve this problem, one can replace
the minimum by the average over a given number of quartets
with smallest indices to obtain a refined system of splits, as
suggested in Moulton et al. (1997). The Refine menu item
implements this idea.

The Bootstrap item runs bootstrap sampling from given
sequence data (Felsenstein, 1985). This is a way to test the
statistical robustness of the computed splits graph. To be pre-
cise, the program repeatedly generates new artificial data sets
by randomly choosing k (not necessarily distinct) sites in the
original data set. The user is prompted to supply the number
of times this is done, whereas k usually equals the length of
the original sequences. For each such data set, the splits
graph is then computed. At the end of this procedure, each
split in the original splits graph is labeled by the percentage
of computed splits graphs that it occurred in, thus indicating
the statistical robustness of each split. The st_bootstrap block
contains a full listing of all splits that occurred.

Finally, the Window menu contains a Syntax and Show
submenu that can be used to obtain a listing of the syntax or
current contents of a selected ‘nexus block’. The Get Info
item gives general information on the current document.
Moreover, the menu contains a list of the currently open win-
dows.
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Windows

SplitsTree displays two windows. The SplitsTree Console is
used to print messages when reading or computing data. It
also accepts typed commands and nexus blocks. Moreover,
it is used to present information requested using the menu
items described in the preceding paragraph. The second win-
dow, called the document window, displays the splits graph
computed for the given data set. The bottom of this window
contains a line of information on the current data and how
they were computed (see Figure 1).

The splits graph displayed in the document window can be
manipulated using the mouse. Clicking on an edge will high-
light that edge and all other edges representing the same split.
Then, grabbing and dragging any other part of the graph will
rotate the selected edges and thus reshape the graph, without
changing any of the edge lengths. Moreover, the vertex labels
can also be grabbed and dragged.

File format

SplitsTree is based on the new nexus format (Maddison et al.,
1995), which was originally developed for the programs
PAUP (Swofford, 1997) and MacClade (Maddison and
Maddison, 1989). Input data are described in the three stan-
dard block types: taxa, characters and distances. More pre-
cisely, an input file will typically consist of a taxa block list-
ing the names of the given taxa and either a characters block
containing a set of, for example, DNA, RNA, protein or
RFLP sequences, or a distances block containing a distance
or dissimilarity matrix. In Figure 2, we describe the syntax
of these blocks and in Figure 3 an example input file is given.

An output file typically contains a number of additional
blocks that are computed by SplitsTree and are specific to the
program. The names of such blocks all have the prefix ‘st_’.
The st_splits, st_graph and st_assumptions blocks contain
the split system, the splits graph and the assumptions made,
respectively. More precisely, the latter block describes how
the data were processed, e.g. whether sites were excluded,
which distance transformation was applied, and which
method was used to compute the splits, in other words, which
items from the Options and Method menus were in effect.

Additionally, the program will generate a st_spectra block
if spectral analysis was used, a st_bootstrap block if boot-
strapping was applied, or an st_extras block if one of the
additional computations offered by the program was
employed. As mentioned above, the program offers an on-
line description of the syntax of all blocks that it understands.

Implementation

This paper describes the interactive Macintosh version of
SplitsTree, which is based on a kernel program that is essen-
tially a nexus interpreter that reads nexus blocks from a file

Fig. 2. Syntax of the three main input blocks. In this figure, square
brackets indicate optional items and curly brackets indicate a choice
of items. The syntax follows the standard definition of these blocks
(Maddison et al., 1995), expect for the two additional commands
marked by a (*). The CHARWEIGHTS item is used to enter weights
when specifying RFLP data. The FORCE_METRIC item can be set
by the program when the triangle inequalities do not hold and an
offset must be added to force them to.

or the keyboard and outputs nexus blocks and PostScript.
The kernel is written in C++ and thus can be compiled on any
computer, and executables are available for a number of dif-
ferent Unix systems. We plan to develop an interactive Win-
dows version in the future.

Example

The splits graph depicted in Figure 1 was obtained by apply-
ing the LogDet transformation and split decomposition to all
sites in an rDNA data set (indicated in Figure 3). For these
data, the splits graph in Figure 1 reveals that a conflicting
relationship exists between the cyanobacterium Anacystis
and the chloroplasts of Euglena and Olithodiscus. Previous
biological studies suggest that the correct split within this
unresolved part of the splits graph should actually put Eugle-
na (a chlorophyll a/b-containing plastid) together with the
other chlorophyll a/b-containing taxa (rice, tobacco, Mar-
chantia, Chlamydomonas, Chlorella). That is, Euglena is ex-
pected to split away from the outgroup Anacystis and Olitho-
discus (a chlorophyll a/c-containing plastid). The suggested
reason for the conflicting signal is that the rDNA sequences
in Euglena and Olithodiscus have independently and conver-
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Fig. 3. Example of an input file. Typically, either a characters block
or a distances block will be specified, but not both. The first token
in a file must be ‘#NEXUS’ and the first block must be the taxa
block. Comments are enclosed in square brackets and all comments
between the ‘#NEXUS’ and ‘BEGIN taxa’ tokens are passed on to
the output file by SplitsTree.

gently acquired similar base compositions [see discussions
in Lockhart et al. (1994), Delwiche and Palmer (1995) and
Van der Peer et al. (1996)]. Hence, in this example, the splits
graph indicates both the suggested true phylogenetic signal
and a spurious one resulting from base composition effects.

Comparison of Figure 1 with Figure 4 reiterates the point
made in Lockhart et al. (1994) that the LogDet correction,
which can overcome some such base composition problems,
will not work when invariable sites are included in sequence
analyses. That is, the expected split is only obtained if one
removes the invariable sites from the data, i.e. an appropriate
number of constant sites (using the Exclude Constant Sites…
item) before applying the LogDet transformation (Figure 4
displays the result for 600 constant sites excluded).

In practice, a number of techniques can be used to estimate
the proportion of constant sites that should be removed from
the data when accommodating position rate heterogeneity
(e.g. Lockhart et al., 1996). Note that the removal of invari-
able positions in sequences can be important before analyses
are carried out using both symmetrical (e.g. Jukes Cantor)

Fig. 4. The splits graph obtained from the RNA sequences indicated
in Figure 3 using the LogDet transformation and split decomposition
with 600 constant sites excluded. It contains a split that clearly
separates Euglena from Olithodiscus and Anacystis nidulans, as
discussed in the Example section.

and asymmetrical (e.g. LogDet) correction formulae (Lock-
hart et al., 1996).
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